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Before you start ...

About This Documentation

This documentation describes how to connect HEIDELBERG Jetfire 50 digital printing presses to the
Prinect Production workflow. It also describes in compact form the operation of a Jetfire 50 digital
printing press with the Prinect Production workflow.

Note: The terms "Prinect Production”, Prinect Manager”, ‘Prinect Production Manager’ and
‘Prinect Integration Manager’ have the same meaning in this documentation and refer to the
Prinect workflow version with the most comprehensive range of functions.

Note: The processes and working methods described in the following documentation apply
to the operation of a Jetfire 50 digital printing press with a Prinect Production workflow that
supports offset presses as well as digital printing presses in a "hybrid workflow". This doc-
umentation refers exclusively to the connection of the Jetfire 50 digital printing press to the
Prinect Production workflow and the operation of the press in this system environment.

Prinect Production is a printshop workflow system fully based on the Job Definition Format (JDF). Pri-
nect Production is a component of the HEIDELBERG Prinect product range.

This documentation gives you a brief introduction to connecting a Jetfire 50 digital printing press to
the Prinect workflow and to operating Prinect Cockpit, the user interface of the Prinect workflow. An
example will also show you how to configure and execute a standard work process for digital printing.

Note: The names (e.g. job names, user names, customer names, etc.) and quantities or
dimensions (e.g. delivery quantities, sheet dimensions, paper dimensions, etc.) given in the
following documentation - and in particular in the screenshots shown - as well as other
individual designations used are intended as examples to illustrate how the respective set-
tings and processes work and should under no circumstances be adopted in your config-
urations or production processes without checking.

What You Should Already Know

We assume that you are familiar with the Windows® and Mac 0S° operating systems that are sup-
ported by this application. You should also be familiar with the processes and terms used in a print
shop workflow.

Further Documentation

You can find more information in the following documentation:

« in the Online Help for Prinect Cockpit. See Prinect Cockpit — Online Help.

- The "Quick Start - Prinect Manager CR 55" documentation (as a PDF document) is available as
an introduction to the Prinect offset printing workflow. See Quick Start - Prinect Manager .
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Before you start ...

- The documentation "Quick Start - Prinect DFE CR 55" (as a PDF document) is available as an

introduction to the Prinect digital printing workflow with the Prinect Digital Front End (DFE) and
Versafire digital printing presses. See Quick Start - Prinect DFE .

+ In the User's Guide for HEIDELBERG Prinect Licensing or in the Online Help for License Mana-

ger. See License Manager — Online Help.

+ In the Online Help for Prinect Maintenance Center Prinect Maintenance Center — Online Help.

Typographical Conventions

The following typographical conventions are used in this manual:

- References to other chapters and sections are blue (on the screen) and underlined.

Example: See section "Typographical Conventions", page 6.

+ Quotes are used to indicate menus, folders, names of functions, hardware conditions, switch

settings, system messages, etc.

Example: Set the switch to "off".

+ Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".

+ Keys which you should hold down simultaneously are connected with a plus character.

Example: Press Alt+A.

Important Information

Important information in the text is marked by symbols that are used as follows:

[e)]

NE R P

Warning: Contains information that must be taken into consideration to protect the user
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be met before the subsequent steps can be
performed.
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Introduction to the Prinect Production Workflow

Prerequisite: HEIDELBERG Jetfire 50 digital printing presses can be operated only in a
Prinect Production workflow. You cannot operate the Jetfire 50 with the Prinect DFE
workflow (Digital Front End).

Prinect DFE provides functions for an automated Prinect workflow for output on offset/digital printing
presses. This workflow spans steps ranging from preparation of the digital job data to output of the
production run at the digital printing press and finishing of the printed products.
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What are the components of Prinect Production Workflow?

The Prinect Production Manager is built up on the model of a server-client architecture. The core of
the system consists of a central database and components that control all the processes in the sys-
tem and that regulate communication flow between the single components. Important basic data like
for example, printing materials, user or customer data, color profiles, are stored in the MDS
(MDS=Master Data Store). "Engines" are used for processing within the Prinect workflow.

The central user interface of the Prinect Production Manager is the "Cockpit" that can be installed as
a client application on several computers (Windows and Mac) in the network environment.

Prinect Production Server computer Additional "Client" Cockpit
workstation (Windows or
Mac 0S)
Prinect Cockpit Prinect Cockpit
Communication services, Mas- Prinect Color Toolbox
ter Data Store
Prinect Maintenance Center

#

Prinect engines,
Renderer or

High Performance
Renderer

Prinect Color Toolbox

How do | use the Prinect Production Manager?

The "Cockpit" is the central user interface for all tasks a user performs with Prinect Production Mana-
ger. Cockpit is installed together with the Prinect Production Manager software on the Prinect server
computer. Additional Cockpit clients can be downloaded and installed from the HEIDELBERG Soft-
ware Center via Prinect Maintenance Center (PMC) for both a Windows and a Mac OS operating sys-
tem environment. You can perform the following tasks in the Cockpit:

- Edit basic system settings (set up presses, users and customers, etc.)
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- Configure processing steps ("sequences") for automated job processing and

- create jobs, compile job components (input files, sheet layouts), view and monitor jobs, submit
jobs or job data for processing or for approval, check the job status.

fessional software should be installed on each workstation using Prinect Cockpit. Acrobat is
used for various purposes during the processing of print jobs in the Prinect workflow, e.g.
for the visual control of PDF documents or for using the Acrobat plug-ins "Prinect PDF Tool-
box" or "Prinect Imposition Editor". Acrobat Standard or Professional is not included in the
shipment of the Heidelberg Prinect software. As a minimum solution, the free Adobe Reader
should be installed so that you can at least open and view the PDF documents processed
with Prinect. The licensee of the Prinect software is responsible for ensuring that a suitable
version of Acrobat is installed on the computer in question before starting the installation
of the Prinect components.

Prerequisite: A licensed, if possible latest, version of the Adobe Acrobat Standard or Pro-

= Note: Acrobat Standard is only available for Windows. You need Acrobat Professional if you
1 want to utilize advanced Acrobat functions on a Mac.

How to obtain the installation files

Prerequisite: HEIDELBERG offers the "Prinect Production" installation package for operat-

ing Jetfire digital printing presses with the Prinect workflow. In addition to the offset work-
flow, Prinect Production supports all digital printing presses that are generally supported by
the Prinect workflow. The "Prinect Common Database" and "Prinect Renderer" installation
packages are also required for the Prinect Production workflow. These installation packages
and installation packages for Prinect Cockpit (Windows and Mac) for additional Cockpit
installations can be downloaded in Prinect Maintenance Center in the "Product Installati-
ons" view.

Warning: We generally recommend that HEIDELBERG Support should be consulted for the
A installation of Prinect Production software, as the installation process is complex and
requires special knowledge.

If the Prinect Production software is initially to be installed in a system environment in which no other
Prinect product is already installed, normally Prinect Maintenance Center is not available in the sys-
tem environment. In this case, you can download the Prinect Maintenance Center installation pack-
age from the HEIDELBERG homepage in the "Software" menu under "Prinect Software Downloads"
and install it in your system environment.

See Prinect Software Downloads.

Following the installation of the Prinect Maintenance Center (PMC) software, you must register your
company and at least one user in the HEIDELBERG Customer Portal in the PMC user interface and

log in to Customer Portal. Details about this can be found in the Online Help of the Prinect Mainte-
nance Center. See Prinect Maintenance Center — Online Help.
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How Does Licensing Work?

license option must be activated in addition to the general Prinect Production licenses. If
this license option is not included in your license key, you can request the activation of this
license option from the HEIDELBERG licensing department. The activation will be transmit-
ted online to your local License Server.

Prerequisite: To operate the HEIDELBERG Jetfire 50 digital printing press, the "Jetfire 50"

With each installation of the Prinect Production software, all software components of the "Prinect
Production" installation package are installed regardless of the licenses purchased in each case. Pri-
nect Maintenance Center, however, is not part of this installation package. A license key activates the
permanently usable options. License administration takes place in the "Prinect Licensing" module.
Prinect Licensing consists of two software components, the License Server and the License Manager.
License activation takes place online with the HEIDELBERG Trust Service. As of version 2019 licensing
via a dongle is no longer supported, apart from a few exceptions. The switchover to online licensing
is also applicable for any version upgrades.

Online licensing is based on an online protection certificate that is enabled during installation of the
software. For this reason, before installing the Prinect Production software, you must request an
installation code from the HEIDELBERG licensing department, which you enter at the appropriate
point during installation of the License Manager software to activate the Prinect software. The certif-
icate is connected to real or virtual hardware and is automatically renewed daily. If the Internet con-
nection to the HEIDELBERG Trust Center should fail temporarily, the existing certificate continues to
be valid for 30 days. Online licensing is managed with the "Prinect Licensing" module, while the con-
nection to the HEIDELBERG Trust Center is established via Prinect Maintenance Center.

The License Server and the License Manager interact in a "client-server architecture". Administration
of the licenses is done in the License Server whereas the License Manager depicts the user interface.
Normally, the License Server is installed on the Prinect Server. In bigger system environments with
numerous Prinect servers and/or other Prinect products, it may be advisable to set up a dedicated
License Server PC. The License Manager user interface can be installed on several client computers
at the same time.

. Note: You can find details about licensing in the "HEIDELBERG Prinect Licensing — User's
Guide" or in the Online Help of License Manager. See License Manager — Online Help.

Prinect Maintenance Center (PMC)

In the print shop, Prinect Maintenance Center establishes the connection to HEIDELBERG Prinect
Software Center (for software downloads), HEIDELBERG Trust Service (for licensing) and HEIDEL-
BERG Customer Portal Control Center.

Prinect Maintenance Center is responsible for various tasks within the Prinect system environment:

- For providing the files for installing the Prinect software in the print shop,

- For regularly checking for available software updates and making them available,
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- For controlling the update installations, taking into account the dependencies that exist inter-
nally between the Prinect components, and

« For running background installations without user interaction.

A prerequisite for the provision of Prinect software components is that the print shop is registered as
an organization and logged in to the HEIDELBERG Customer Portal with a user account. HEIDELBERG
Customer Portal provides access to the digital services of

Heidelberger Druckmaschinen AG.

Sequence Templates

In Cockpit, the processing steps are configured in the form of so-called "sequence templates". These
templates contain all the process steps that are to be carried out with the content data of the print
jobs up to actual printing. Divided into different options, sequence templates contain all the key set-
tings that are required for correct printing. These templates only have to be set up once and after that
they can be used for any number of print jobs that need the same setup. Sequence templates of dif-
ferent types can be combined to form group templates. For that reason, it is generally sufficient to
enter a few basic data when creating a new print job and to select the matching sequence templates
or a group template. See "Group Templates", page 12. All the output parameters are predefined in the
sequence templates and do not need to be reconfigured.

Basic sequence templates

The most important sequence types for digital printing output are the "Qualify" and "PagePrint"
sequences. Other types of sequences are available for advanced workflow variants.

- The Qualify sequence prepares documents that are available in PDF format for processing with
the Prinect workflow in a "Normalization" option. If the existing PDF format is not suitable for
processing with the Prinect workflow, these PDF documents can be prepared with the "Normal-
ization engine" so that further processing can take place in the Prinect workflow ("Refrying" pro-
cess). The incoming documents must always be in a cleaned PDF format suitable for the
subsequent process stages. In a "Preflight" option, the input documents can be checked, for
example, for the presence of all required fonts, correct image resolution, use of transparency
elements, etc. You can customize the preflight settings to suit your needs.

- After the Qualify sequence, the pages can be subjected to a Prepare sequence. This can be nec-
essary, for example, if you wish to reduce transparency elements found in several layers of a PDF
to one layer. The Prepare sequence also offers advanced color management options.

« In a PagePrint sequence, page output for digital printing is configured. In this context, "page out-
put" means that the pages contained in the PDF job files are imposed interactively within the Pri-
nect Production workflow, while ImposedPrint sequences process already imposed sheet
layouts.

- An ImposedPrint sequence is used to configure the output of imposed sheet layouts for digital
printing.
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Introduction

Group Templates

To configure standardized processing, you can group several sequence templates to "group tem-
plates". In a group template, you can link single sequences by drawing connecting lines between
them. These kind of linked sequence templates can run automatically one after the other without
intervention from the user. Linking sequence templates is optional and the sequence templates are
not linked in the examples shown below. You can save separate group templates for different
sequence configurations.

Job Processing Workflow

The graphic below shows you a diagram of the basic workflow in processing job files in the Prinect
workflow:
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—

PDF

file
Are supplied to the print shop as PDF
or PDF/VT files or as image files

=

TP
file

Files from a customer or from
an editorial department

Preparation (Qualify) * PagePrint/ImposedPrint * Digital Printing Terminal

PRISMAsync
Front End

Jetfire 50 digital printing press

1. The print shop customer supplies the documents and/or images required for the print job to the
print shop in the form of PDF or PDF/VT files or image files (e.g. in JPEG format). The complete
definition of the customer print job can take place, for example, in an app of the HEIDELBERG
Customer Portal or in a web store by transferring the PDF and image files to the print shop via
online upload.
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A new job is created in Prinect Cockpit when the input files are available in Cockpit. If you

expect a number of print jobs for a certain customer, you can create a job group where you can
group the jobs of this customer. Furthermore, it is advisable to enter the customer data (name,
contact, etc.) into the Prinect customer administration and assign the new job to the customer.

When you create a new print job, you can at this stage assign several sequence templates or a
group template to the job.

A print job opens in the Cockpit after it has been created in the Prinect workflow. You can now
check its settings and, if necessary, change them. In this way, you can, for example, modify indi-
vidual sequence templates.

Once the job has been created, the files to be printed are added to the job. You can define a job
as "started" when you are creating it. In this case, the added files are processed straight away,
usually with a Qualify sequence which contains a preflight step that checks the files for possible
errors (missing fonts, image resolutions too low, etc.). You can then configure job parameters
such as color settings (color sequence, handling of spot colors, etc.).

Alternatively, you can also define job templates for creating new print jobs automatically. It is

then sufficient to transfer the files to be output to a hotfolder using "drag & drop" and a new job
is automatically created with the default settings of the job template (see section "Create new
Print Jobs automatically via Drag & Drop", page 91).

Each of the pages must be imposed for output to a digital printing press. This is done either
interactively in the "digital printing" step or in an upstream step in which the sheet layouts are
imposed separately (e.g. with Prinect Signa Station or with Prinect Imposition Editor). In this
case, an ImposedPrint sequence rather than a PagePrint sequence is used for digital printing. All
settings for the print output — including finishing — are made in the "Digital Printing" step.

When configuring the "Digital Printing" step is completed, the print jobs are submitted to the
Digital Printing Terminal (part of Prinect Cockpit). You can use the Digital Printing Terminal in
two modes:

- In automatic mode, incoming print jobs are forwarded to the digital printing press auto-
matically, i.e. without the need for operator intervention. If there are several "similar”
digital printing presses in the system environment, these presses can be combined to
form a "cluster”. In the case of Jetfire 50 presses, for example, two Jetfire 50 presses
would be "of the same type", but not a Jetfire 50 press and a digital printing press of a
different type. Similar presses in a cluster can be operated in "load balancing" mode, i.e.
the press that is currently available or least busy is automatically activated. See "Cluster
setup”, page 47.

- In manual mode, the operator controls the order in which printing takes place and - if
several digital printing presses are available — which of the presses is controlled.

in which no new print data arrives at the press. In order to prevent unnecessary ink con-

Note: Jetfire 50 automatically carries out a print head cleaning process after every "pause”

14

sumption and unnecessary interruptions to the continuous printing process due to too fre-
quent cleaning processes, it is strongly recommended to submit job data to the press as
continuously as possible.

Continuous submission of print data to the Jetfire 50 press can be achieved by "collecting”
sufficient data to be output in Digital Printing Terminal before this data is then forwarded to
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the press or to the PRISMAsync front end.

If necessary, check whether it makes sense to use an additional color proofer for the page

proof within the Prinect environment to prevent proof outputs on the Jetfire 50 press trig-

gering print head cleaning processes.

Color proofers are set up with the "Prinect Color Proof Pro" software and connected to Pri-
nect Manager. Linearization and calibration of proofers is also possible with Color Proof Pro.
See also Prinect Color Proof Pro - Online Help.

Connecting the Jetfire 50 press to the Prinect workflow

Prerequisite: Before you can connect a Jetfire 50 press to the Prinect workflow, the press
must be fully installed and the PRISMAsync front end must be connected to the print shop
network.

The Jetfire press is set up in the Prinect Cockpit in the "Administration > digital printing presses”
view:

IS

Praduct Types

1. Click "digital printing presses".
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2. Click the "Plus" symbol to add a new digital printing press. The "Define device" dialog appears:
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Define device *

Define device

Device name
Jeffirre 50
Device ID

2200

Cost center
Standard (1)

Vendors
Heidelberg

Model line
Jetfire

Machine Capabilities

Servername

Connection test

Mo connection test running

Abbrechen

3. Complete the dialog with available values:

- "Device name": If possible, enter a "descriptive" device name that makes it easy to iden-
tify the device, for example "Jetfire 50". This name is used to identify the press in the
Cockpit UI.

- "Device ID": As the device ID, enter an identifier - e.g. a multi-digit number - that
uniquely identifies the device in the Prinect environment, i.e. the device ID must not have
already been assigned in the Prinect system environment.

- "Cost center": Select a cost center for the press defined in the Prinect environment.

- "Vendors": Select the "Heidelberg" entry.

Jetfire 50 - Prinect Production Connection — Quick Start Guide 17
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- "Model line": "Jetfire" has been entered here (automatic detection).
- "Machine Capabilities": "Jetfire 50" has been entered here (automatic detection).

- "Servername": Enter the name of the PC where the PRISMAsync front end has been
installed.

- "Port": Enter the Internet port address and the port extension of the PRISMAsync front
end.

- "URL": The URL of the PRISMAsync front end is made up of the "Server name" and
"Port". If necessary, ask your system administrator for the correct URL.

- "Connection test": It is strongly recommended that you click this button before confirm-
ing the dialog with "OK" to check whether the PRISMAsync front end is accessible in the
network.

4. Once the device has been created, a new entry is displayed in the "Devices" list:

5. If you select the entry, the properties are displayed in the right-hand part of the window. By
clicking the "Settings" button (1), you can subsequently check or edit the properties. You can
delete the entry by clicking the "Delete" button (2).

6. Click "Overview" to return to the "Administration" view.
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User set-up

Prerequisite: Before you set up new users in Prinect Cockpit, the corresponding user
accounts must be set up in the Windows system administration of the Prinect Server com-
puter. The future Cockpit users must first be defined with a Windows user account on the
Prinect Server or in a Windows domain and be a member of the Windows user group "Pri-
nect Operators". Without this setup and configuration as Windows users, Prinect users can-
not make any changes to the settings or job data in Prinect Cockpit. For more information,
go to Cockpit Help, section "Setting up a new Prinect user".

After installing the Prinect Production software for the first time, you must set up the print shop

employees who are to operate the Prinect workflow as "Prinect users". When setting up, you assign
the individual users to the intended roles by assigning them to a specific user group and assign cor-
responding access rights. To mange users, go to the "Administration" view of Prinect Cockpit under

"Users".

Note: If the Prinect software has been newly installed, you can log in to Prinect Cockpit with
the user name "Administrator" without a password to set up the users. For security reasons,
it is then recommended that you set up at least one user with administrator rights and then
delete the "Administrator" user from the user administration.

1. Go to "Administration" and click "Users" (1):

Settings

System Preferences Users Customers Planned Tasks

2. The User Management opens. Click the "New" button. The "Create User" dialog displays:
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User Mame: |PetrerP

5] Create User >

Profile Picture
Select...
ord for OS5 Login

prinect

Person
Employee 1D

Cancel

Enter the following user data:

- User Name: Type the user name ("PeterP" in our example). This user name is used as

user account in the Prinect environment - in particular in Cockpit. At the same time, this
user account must be defined as a Windows user on the operating system of the Prinect
Server computer (see "Prerequisites” above). To use the corresponding Windows user
account as a Prinect user account, the "Password for OS Login" option must be
enabled. The Prinect user can only access the "PTConfig", "PTJobs" and "PTDocs" fold-
ers with write permissions if a correspondingly configured Windows user account is also
used for the Prinect user with the protection function enabled. Without these authoriza-
tions, no changes to the settings or job data can be made or saved in Cockpit. Enter a
user name here that is defined on the Prinect server computer as an appropriately con-
figured Windows user. In future, this (or another appropriately configured) user account
will be used to log in to Cockpit.

Note: If you operate the Cockpit on a computer other than the Prinect Server, i.e. on a Win-
dows or Mac client, the Prinect user does not have to be a system user on the client com-
puter at the same time, but only on the Prinect Server.

- Optionally, you can specify the name of a Windows domain if the Prinect Server and — if

available — the client computers and the corresponding users are organized in a domain.

For more information on the protection function, go to "Administration > Security" in
Cockpit Help.
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3. In "Person", you can enter more specific user data (E-mail, Employee ID, First Name, Family
Name). As an option, you can choose a profile image in the file system and assign it to the user.

4. Confirm the dialog with "OK". The new user is now displayed in the "Name" column. Select this
table entry and assign the groups to the user he/she is to become a member by selecting the
desired groups in the "Available groups" list and adding them to the "Member of" list by double-
clicking or by clicking "Add".

0 Note: In the vertical tabs "Groups" and "Access rights" (top left of the window), you can edit
or redefine the user groups and configure the corresponding access rights. You can find
more details about this in Cockpit Help, "Administration - Users".

5. Click "Save" to terminate the user configuration. Click "Overview" to leave the "Users" adminis-
tration area.

Set up Customers

In daily work with the Prinect workflow, the edited jobs are normally assigned to the customers con-
cerned. For this purpose, Prinect Production has its own customer administration. Customer data are
filed in the Master Data Store and are available at various points in the Prinect environment.

Note: Details about customer administration can be found in the Prinect Cockpit Online
Help.

For example, you set up a "virtual customer" here to be able to assign a customer to the demo jobs
used in this documentation.

1.  Go to "Administration" and click "Customers" (1).

Administration

Settings

e 5]

System Preferences Customers Planned Tasks

2. The User Administration opens. Click the "New" button. The "Create Customer" dialog opens:
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ﬁ Create Custormer

Bus

HD Printshop

mer 1D
Mickname:

Ferson Open...

Cancel

Enter the following customer data:
- Sector: Business
- Name: HD Printshop
- Customer ID: 0001

- Nickname HDP

3. Click "Open" beside "Person". The "Create Person" dialog opens:

Create Person *
Person

Title: fr
First Mame: William

Bauer

Additional Mame:
Job Title:

Mickname: WillB

Communication Channels

Cancel
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Enter the following personal details:
- Title: Mr.
- First Name: William
- Family Name: Bauer
- Nickname WillB
- Language: English

These details about the contact are enough for our purposes. In "Communication Channels",
you can enter data such as phone number, mobile number, e-mail address, fax number or Web
address.

Confirm the "Create Person" dialog with "OK".
Then confirm the "Create Customer" dialog also with "OK".

4. The "Customers" window now displays your new customer at the top left of the customer list (1).

Mark your customer and fill out the "Address" section.

- Street: Hauptstrasse 1
- Postal Code: 10111

- City: Berlin

- Region: Berlin

- Country Code: DE

- Country: Germany
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5. Confirm your inputs with "Save". Close the "Customers" window by clicking "Overview".

Create a Job

In the Prinect workflow, a job contains all the information and files required for processing. New jobs
are created in the "Jobs" view using the "New job" button. The following information is requested
when defining a new job:

- Basic job data
- Job Number

A job number must be assigned to every job. A job number generally consists of a num-
ber of letters and/or digits. The job number identifies each job in Prinect Production. For
that reason, each job must have a unique job number. This is checked when you enter a
new job number. If the job number you entered already exists, the number displayed is
red and you cannot enter any more data until you enter a job number that is not yet
used.

- Job Name

The job name is the identifier that is used to display a job in the Cockpit user interface.
The job name, too, must also be unique in the system. This means that you must give
each job a job name that is not yet used as a job name in the system. After you enter the
job number, hit the Tab key. The job number is copied automatically to the "Job Name"
box. You can use the job number also as the job name or you can edit this entry.

- Documents

This is where you can assign PDF or image files to a job while you are creating it. To do
this, click "Browse" and select the document files in the file system. You can also skip
this step and add the document files later after the job is created and opened.

- Job Group

Generally, it is advisable to assign each job to a job group. This lets you, for example, use
a separate job group for each customer you have or to create a "pool group" for single
jobs of various customers. If a job-related group structure already exists in the system,
the group that was selected before the "New job" button was pressed is entered in this
box. By clicking "Change", you can select a different, available group or create a new
group and select it.

- Job Home

In this box, you set the folder in which all the job-specific data in the file system will be
filed. Normally, the job files are filed in the "PTJobs" system folder (e.g. E:\PTJobs) of the
Prinect Server and here in the "Jobs" subfolder. A subfolder with the name of the job

group is created in the "PTJobs" folder. A folder with the job name is created in this sub-
folder. All the job-specific data are filed in this folder. You must click the lock icon if you
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do not wish to use this default. This breaks the link between job group and job folder and
you can use "Change" to select another folder for the job files. We recommend that you
do this only in exceptional cases because the defaults ensure that the job files can be
found fast in the system. The "PTJobs" folder is shared in the network, meaning that
other computers in the system environment, for example, other Cockpit computers can
access the job files. In addition, the central storage location of all job files makes it easier
to back up the data.

« Customer Data

Assignment of customer data to a job is optional but we strongly recommend that you use the
Prinect customer administration (see section "Set up Customers", page 21) to assign an appro-
priate customer account to each job. The customer names registered in the customer adminis-
tration are offered for selection in the "Customer name" list box. The "Customer ID" and "Nick-
name" boxes are then filled automatically.

- Customer Job ID

The assigned Prinect job number is entered by default in this box. This is where you can
enter customer job numbers in the case that your customers use their own job numbers
that are different to the Prinect job numbers.

- Customer Job Name

Corresponding to the customer job number, you can here enter a customer job name
that differs from the Prinect job number.

- Processing:

In this view, you can assign one or more sequence templates or group sequence templates to
the job with "Add". By doing this, you define how the job will be processed in the Prinect work-
flow. You can still edit each of the steps set in the sequence templates after the job is created.
This is where you can save the selected sequences as a template for new jobs generated auto-
matically (see also chapter "Automatic Creation and Qutput of New Jobs using Drag-and-Drop",
page 91). You can skip this step for the time being and assign the required sequence templates
later in the open job.

+ Scheduling
You can enter the following planning data here:
- Set Due Date

You can select a date for the scheduled due date by clicking the calendar icon. This date
is for logging only and does not control the time printing will run.

- Responsible

This is where the Prinect user who is responsible for processing the job is entered. By
default, this is the name of the user logged in to the Cockpit. Using "Select", you can
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select a different name from the Prinect user administration. The user must have the
required permissions in the Prinect system.

- Job type

You can select one of the following job types in the list box: Production, Product, Prelim-
inary job, CAD (for packaging printing), Reuse, Job Template, Cloud.

- Job Priority

You can assign a priority to each job. For example, this lets you set that very urgent jobs
are given a higher priority and are processed before other jobs.

- Pages

Generally, the job data or information from the customer tells you how many pages there
are in one copy of print product. Together with the planned delivery quantity, you can
estimate how big a job will be.

- Delivery quantity
The delivery quantity indicates how many copies of each print product will be printed.
The new job is created after you click "Finish" and opens immediately if the "Start Job" option is

enabled.

Processing steps and parameters of a Prinect job

In the Prinect workflow, each print job goes through several processing steps until it is printed. The
properties of a Prinect job can be viewed and configured in various parameter areas in the "Jobs"
view of Cockpit. After the job is set up, you start it and the steps are run one after the other.

A job contains the following sections or steps:

+ "Product Description" section

This is where data like delivery quantity and details about the customer for whom the job was
created are entered.

+ 'Processing' Section

This is where the processing sequences or group sequences are added to the job and displayed
in a graphical overview. You can edit sequence settings individually here (by double-clicking the
respective sequence symbol).

+ "Properties" Group

This is where other properties like delivery quantity, pages planned in a job, predecessor job
details or gang job details are recorded.
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« "Colors" Group

This is where you configure the output type of the print colors defined in the job (color defini-
tions, color sequence, usage, etc.).

+ "Printing Process" Section

This is where parameters relating to the printing process (e.g. print order of pages, output color
profile) are displayed or configured.

- "Documents" Step
Document (PDF or image) files are added to the job in this step.
- "Pages" Step

Page lists are defined in this step and the document pages are assigned to the page list place-
holders. In the examples described below, this is done automatically so that this step does not
require any manual intervention.

- "Digital Printing" Step

In the "Digital Printing" step, pages are imposed interactively and you set output and finishing
options. Furthermore, this step has options for examining the imposed sheets in detail (magni-
fier function, etc.) and you can, for example, view a preview of a finished booklet in which you
can also scroll through.

- "History" Section

List of the actions performed throughout the job.

Setting up a cluster of digital printing presses

You can combine several digital printing presses of the same type (e.g. two Jetfire 50 or two Versafire
printing machines) into a cluster. You can then submit print jobs to the cluster. This means that the
decision as to which of the presses belonging to the group is to be used for printing is only made at
the start of printing. If the Digital Printing Terminal of Prinect Cockpit is operated in automatic mode
and a cluster of digital printing presses is selected as the output destination, these digital printing
presses are automatically utilized optimally, as the press with the highest availability is always
selected. In manual mode, you can select either one of the individual presses or the cluster and sub-
mit the print jobs accordingly.

= Note: When setting up a cluster, you should ensure that the presses involved have the same
properties, e.g. that they have the same paper format, the same substrates and the same
inks and, if necessary, the same finishing options, as presses configured in the cluster are
operated in "load balancing”. "Load balancing" means that a decision is automatically made
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as to which press is to be activated based on the current workload during operation. How-
ever, some properties of the presses can be configured as selection criteria for the automat-
ically controlled presses. See also "Cluster setup”, page 47.

Prerequisite: The Prinect system environment contains a minimum of two suitable and

configured digital printing presses. In the following example, two Versafire EM digital prin-
ting presses are to be combined to form a cluster. You can also set up clusters of digital
printing presses of other types in the same way.

Proceed as follows to set up a cluster of digital printing presses:

1. Open the "Administration > System" view in Cockpit, select the Prinect Server entry in the struc-
ture display on the left and click on the "Show Clusters" button.

2. Select the "DigitalPagePrinter" entry in the right-hand window area and call up the "Create Clus-
ter" context menu command.
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Hide Clusters

Cancel

The cluster is being created. You must now assign presses to the cluster.

4. Select the first press in the left-hand window area under "DigitalService" (1) and call up the "Add
to Cluster" context menu command.

Jetfire 50 - Prinect Production Connection — Quick Start Guide 29



Introduction

£ (g]‘

w3 Imp

W) Mormali

L% PDFCor

IDPM

Add to Cluster. .
T

L4
»
»
b
4
»
L4
4

Hide Clusters

1vvvvﬂ|:'

| Available Clusters
Ik WEB

eank

30

Cancel

Version CR 55



Introduction

5. Select the cluster you created, "Versafire_EM_Cluster" in our example, and confirm with "OK".
6. Repeat steps 4 and 5 also for the second press. Both presses are now part of the cluster.

7. To check the configuration, click the triangle preceding the "DigitalPagePrinter" entry in the
right-hand window area. The contents of this entry displays. To view the two digital printing
presses, click the triangle preceding the "Versafire_EM_Cluster" entry:

NDPM (1)

O = Marrow WEB Device

O

Interaction
JobExport (3)
JohHetfolder

Jobimpart

3
5
>
>
»
»
>
>
>
>
»
>
»
>
b.
',.
’.
3

Hide Clusters

8. You can now toggle to the "standard" representation by clicking "Hide Clusters".

Configure Sequence Templates
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Prerequisite: To ensure that a "PagePrint" sequence template required for digital print out-
put is available, a suitable digital printing press must be set up in the Prinect system. In

addition to installing the press, the press must be set up in Prinect Cockpit in the "Admini-
stration > digital printing presses" view. You will find details about the connection of digital
printing presses in the Online Help of the Prinect Cockpit in "Connecting Machines > Con-
necting digital printing presses". You can also set up clusters for Jetfire 50 or Versafire dig-
ital printing presses (EV and EP or later). See "Setting up a cluster of digital printing
presses", page 27.

To configure the sequence templates needed for the examples below, proceed as follows:
1. Go to "Administration" and click "Templates".
Administration
Settings
-\ oy
System ces - E-mail

Resources

X

| Templates § CC Profiles Preflight Profiles Dynamic Marks 3 ch Caolors 3

2. The "Templates" window opens. Click the folder icon beside "Sequence Templates" to display
the single sequence items.
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Configure a Qualify Sequence

Modified by

GoDDD
+H

S

a
|
(=l

1. Highlight the "Qualify" sequence type (1) and click "New" (2).

The setup section for a new Qualify sequence opens:

Overview

Untitied (Qualify)

Set up the parameters for this sequence as follows:

2. Leave "Normalizing", "Split Document” and "Destination" disabled or as they are.
Enable "Hotfolder" and leave the defaults as they are.

Enable the "Preflight" option and display the parameters by clicking the small triangle before the
check box.

5. Click "Browse" in the "Heidelberg Preflight Profile" section of the "Actions" tab. Select the
"CMYKDefault.hpp" profile.
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Fonts.

6. Click "Save as". The "Save Template" dialog opens:

Save Template *

O  Qualify

Comment:

Customer 1D: 0001

Product C

Product Types:

Cancel New Folder...

7. Type in "Qualify_HDCity" as the name and select "HD Printshop" as the customer with "Edit" in
"Customer ID". All the customers registered in the Prinect customer administration are offered
for selection. The respective box is completed with the customer ID (0001 in the example). Con-
firm the "Save Template" dialog with "OK".

8. Click "Close". The template overview displays.
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Configure a PagePrint Sequence

Prerequisite: A "PagePrint" sequence type is available only if at least one digital printing
press - a Jetfire 50 digital printing press in our example - is connected to and set up in Pri-
nect Production.

In the "Templates" view, highlight "PagePrint" in "Sequence Templates" and click "New".

"Accept approved pages only" Option

This option is intended for an approval workflow in which the customer or a print shop employee
must approve the prepared documents before the print output is started. If this option is enabled,
only PDF pages with an "approved" status will be processed in the workflow. You will find more
details about the approval workflow in the Cockpit Online Help. We will leave this option disabled.

"AutolmposePDF" Option

This option is always enabled and cannot be modified. It ensures that all document pages are always
assigned to the corresponding page list placeholders in digital printing. The page lists are generated
automatically according to the number of pages and page format defined in the job settings. In the
Prinect offset printing workflow, the content pages of the supplied document files normally have to
be assigned to the page placeholders of a page list in a special imposition work step. For this purpose,
the required page lists are generated manually or taken from an imported sheet layout. In digital prin-
ting, this imposition process is carried out automatically with the "AutolmposePDF" option.

"Digital Printing" option

With this option, you can set up parameters for paper, pages, layout, print marks, color settings as
well as print and finishing settings and save them as a template. These settings are applied later
when configuring the "Digital printing" work step in the open job and can be customized there.

Digital Printing Press selection

In the "on" list box select the digital printing press for which you will set up this PagePrint sequence
template. If there is only one digital printing press in the system, this press will automatically appear
here.

= Note: If several digital printing presses are combined into a cluster, you can select a cluster
of digital printing presses instead of a single digital printing press in the "on" list box. See
also "Setting up a cluster of digital printing presses", page 27. In this case, the digital prin-
ting presses in the cluster are then controlled with the parameters of this PagePrint
sequence and operated in load balancing mode.

Configuration of paper and page settings

1. Open the "Digital Printing" step and set, for example, an A3 paper type as the paper in the
"Paper and page settings" tab:
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Overview

PagePrint_HDCity (P

420297

The paper types are set up at the digital printing press or at the PRISMAsync front end, and the
paper data is sent to Prinect Cockpit. You can select the paper type in the "Paper” list box. If you
change the paper size, the new size displays at once in the preview pane.

On Jetfire 50 digital printing presses it is possible to print the cover pages (the first two and last
two pages of the PDF document) on different paper. You must enable the "Cover" option to use
this function. You can then expand the respective parameter section and make your settings. In
the example, the cover pages are to be printed on the same paper as the content pages.

Note: In the page preview, the cover pages are highlighted by a dark yellow label.

36

Leave the option "Non-printing Margin" unchanged (0.0). It can be a good idea for some jobs to
specify a non-printable margin to prevent, for example, so that logos or business cards, for
example, are not printed right up to the edge of the paper.

Leave "Subject Offset (manual)" disabled.

Note: This option lets you manually set the horizontal and vertical spacing between the sin-
gle subjects on the printing material. You can use this, for example, for label or business
card printing.

In "Imposition Trimmed Size" leave "From PDF" as it is. Likewise, leave "Scale" as "100%" and
"Page Policies" as "Fit to Size". "Expected Orientation" is set to "Portrait" and cannot be changed
if "From PDF" is set.

In the "Bleed and Trim Allowance" section enter 3.0 mm in the "Bleed" box. Then hit the Tab key.
The new value is applied to the preview. Set "Trim Allowance" to "Automatic".
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Configuration of the layout settings

Booklet Settings

Binding | Saddlestitch

Db ng
O by shifting

Creeping 01 =

Back Margin 1.0 5

Gripper for Sacdlesttcher (Collator)

MNone b4

Press Sheet Layout

Columns | Repeat

Rows ! Repeat

—_

Go to the "Layout settings" tab and select the "booklet layout" (1).
2. Select "Saddlestitch" in the "Binding" list box (2).

3. Enable "AutoArrange Folding Sheets" (3).

4. Enter a value of 0.1 mm in "Creeping" (4).

5. Enter a value of 1.0 mm in "Back Margin" (5).

Leave all other settings as they are. You can find more details about each of the options in the Cockpit
Online Help.

. Note: Use the "custom layout scheme" button (6) to open the Layout Scheme Editor where
you can create a custom layout scheme. You can find details about this in the Cockpit
Online Help (F1 key).
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Configuration of the print mark settings

1.

38

[] Folding Sheet Cuts
[ cut marks
[ Fold Marks

D Lay Marks

|:| Color Bar

|:| Register Marks

|:| Collating Mark

|:| Info Text

Go to the "Print mark settings" tab. Because no print marks will be used in this example, leave

all the options disabled or disable any checked options.
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Configuration of the color settings

E = ¢ ®

Enable Color Management

®  w Source Profiles

[D Enable CMYK Color Management
Use Embedded Profiles
If no profile is known
£

¥ EBPC

E] Use Embeclded Profiles
If no profile is known

HDM sRGB Profile icm

Rl | Perceptual

P » HKeepBlack

.34 P SpotColors

= Qutput Profile

1. Go to the "Color Settings" tab. For Jetfire 50 digital printing presses, you can choose between
two different color management processes:

- Enable the "Enable Color Management" option to use the HEIDELBERG Prinect color
management. HEIDELBERG Prinect color management always transforms all color
spaces defined in the job into an (L*a*b*) intermediate color space.

If the "Enable Color Management" option is enabled, Prinect color management con-
verts the colors via the intermediate color space into the output color space of the press.
In this case the PRISMAsync color management is disabled.
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40

If the "Enable Color Management" option is disabled, the color management of the
PRISMAsync front end uses the press and paper profiles to convert the colors directly
into the output color space.

Caution: If the print job contains overprinting spot colors, it is strongly recommended to

disable the option "Convert spot colors to process colors" in the "Spot colors" settings area
or leave the option disabled. If this option is disabled, the overprint emulation of the PRIS-
MAsync front end is used.

*PagePrint_HDCity

B ¢ o

®  p» Source Profiles

P » HKeepBlack

gi = SpotColors
|:| Remove Transparent Spet Colors
Remove "DieLing"
D Map Spot Colors to Process Colors

Spot Color Matching...

¥ » OQutput Profile

Note: If you use the Jetfire 50 digital printing press in a "hybrid" workflow, i.e. in a Prinect
system environment with additional other presses, e.g. HEIDELBERG offset presses or Ver-
safire digital printing presses and possibly an additional color proofer, the use of Prinect
color management ensures that the same color management parameters (profiles and algo-
rithms) are applied to all presses and proofers connected to the Prinect workflow for print
output. This ensures consistent color treatment of all print jobs, even if different printing
presses are used. We recommend enabling the HEIDELBERG color management.

- If "Enable Color Management" is not activated, the color management of the
PRISMAsync front end is used instead of the Prinect color management. In this operating
mode, there may be latency times during print output, especially when outputting PDF/
VT jobs, as the conversion of the job colors to the intermediate color space must first be
completed by Prinect color management before the job is submitted to the PRISMAsync
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front end. After submission to PRISMAsync, Prinect can render the other job data some-
what faster than if the "Enable Color Management" option is activated, as the conversion
to the output color space does not take place within the Prinect workflow.

2. Open the "Source Profiles" area.
Leave "Enable CMYK Color Management" and "Use Embedded Profiles" enabled.

3. If needed, you can customize the "Keep Black", "Spot Colors" and "Output Profile" sections by
clicking the respective triangles. These settings are not changed in our example. Details about
these parameters can be found in the Cockpit Online Help.

Configuration of print and finishing settings

Output Delivery

Face Down -
D Mirror Content for Output

[] Separator sheet
[ rpallet sheet

[ Insert

[] Cutting

Image Shift

Print Options

High Capacity Stacker
Output Tray Stacker Tray

Shift Mode Off

1. Go to the "Print and finishing settings" tab.

2. Different print and post-processing settings are available depending on the equipment of the
press. Make settings according to the requirements of the print jobs that are to be processed
with this sequence. Information on the print and post-processing settings can be found in the
documentation for your press. Some configuration settings are described as examples in Cockpit
Help.
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Save sequence template
1. Click "Save as". The "Save Template" dialog opens.
2. Type "PagePrint_HDCity" in the "Template Name" box.

3. Assign the customer "HD Printshop” to the sequence template by clicking "Edit" next to the
"Customer ID" field and confirm the dialog with "OK". The dialog box closes.

4. Close the PagePrint sequence by clicking "Close". The template overview displays.

Create a Group Template

For the processing of a job it is not absolutely necessary to create a group template but the use of
group templates facilitates the processing of further print jobs that need similar processing steps. A
group template will be created to illustrate how to define and use a group template.

1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click
"NeW"'

The empty setup window of a group template opens.

Fle | Edit | View | Tools | Help |

B db B E R B HEIDZLB=RG

Overview

Add Template

Save as... Close.

2. Open the "Qualify" folder and select "Qualify_HDCity" (1).
3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.

4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as
follows:
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HEIDELBZRG

5. In the workspace, select "AutoArrange" in the context menu. The icons are placed side by side

and aligned.

6. Click "Save as". The "Save Template" dialog opens.
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] Save Template .
p

Template Name:

HDCity_Group_Template

Comment:

0oo1

Cancel Mew Folder... Delete

7. Type the name "HDCity_Group_Template" and assign the customer "HD Printshop" to the group
template. Confirm the dialog with "OK". The dialog box closes.

8. Click "Close" to close the group template.
9. Click "Overview" to quit the "Template" view.

All the sequence templates needed for a basic workflow are now configured.
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Configure the Digital Printing Terminal

The Digital Printing Terminal is the link between the submitted Prinect print job and the digital prin-
ting press. You will find details about the prerequisites and operation of the Digital Printing Terminal
in the Online Help of the Prinect Cockpit (1).

You can configure the Digital Printing Terminal for two modes:

- for the manual output mode or
- for the automatic output mode.
In the manual output mode, you can customize which print jobs will be sent in which order to the

press.

In the automatic output mode, the print jobs are submitted automatically to the press in the order in
which they arrive at the Digital Printing Terminal.

You open the Digital Printing Terminal by clicking its button (1) in the section toggle.

Fle | Edit | View | Tools | Help |

E & 5 Be [ B HEIDELBERG

(L] i Pending and Finished Print Jobs

If more than one digital printing press, an additional CTP device, or a cluster of digital printing presses
is set up in Prinect Production, you can select the output device or cluster you wish to control in the
Digital Printing Terminal in the device list box (3).

The layout and the contents of the windows of the Digital Printing Terminal are refreshed if you
change the output device. This means that the jobs and details of the new output device you set dis-
play in them.

= Note: The "Jobs" view also has a "Digital Printing Terminal" section. This view is designed
to give you a fast overview of the progress of digital printing. However, you cannot control
printing from this view.
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Controlling the automatic output mode

The automatic output mode is set by default after installation. You can switch to the manual output
mode by disabling "Automatic Output Mode". To do this, click the "Device configuration" button (2).
The "Device configuration" dialog opens:

4] Device configuration et

Device configuration

Delete finished print jobs after

] Quantity
L[] Days

Hide Print Jobhs
[] Testpage of spot color matching
[ TestPrint

You can disable "Automatic Output Mode" here. In this case, you must manually submit all print jobs
to the press in the Digital Printing Terminal.

- Note: Since the Jetfire 50 press should be "supplied" with print data without interruption

as far as possible so that no unnecessary print head cleaning processes are triggered, as
many pending print jobs as possible should be collected in the "Waiting Print Jobs" list
before they are submitted to the Jetfire 50 press. To ensure this, it is strongly
recommended to disable the "Automatic Output Mode" option and submit the collected
print jobs manually to the press. In automatic output mode, each incoming print job is
automatically submitted to the presses as soon as the previously pending jobs have been
printed. If there is a "pause" in this operating mode during which no print jobs arrive at the
Digital Printing Terminal, a print head cleaning process is started.

Controlling a cluster configuration in the Digital Print Terminal

Prerequisite: In order to be able to configure and use a cluster of digital printing presses
in the Digital Printing Terminal, at least one such cluster must be set up. See "Setting up a
cluster of digital printing presses", page 27.

If you want to use several digital printing presses in a cluster, you can configure the type of distribu-
tion of print jobs to the machines in a cluster in the Digital Printing Terminal. To do so, click the
"Device Selection" button. The cluster of these digital printing presses is offered in the device list box
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(3). Click the cluster in the list box. Make sure not to select any presses in the sub menu. Now you
can configure the entire cluster. In a cluster, the print jobs can be distributed among the single
presses of the cluster by different criteria. In this way, the machines of a cluster can be used more
efficiently than individual machines. You configure the distribution details in the "Cluster setup” dia-
log. Click the respective button to open the "Cluster Setup" dialog:

When a cluster is selected, the view of the Digital Printing Terminal changes so that the icons of the
machines contained in the cluster are displayed in the global status area next to the cluster name. In
addition, only the "Print History" and "Cluster Configuration" buttons are available. In the cluster
view, you can use the "Machine" column in each table for sorting or grouping.

When you click one of the machine icons of the cluster, the cluster view changes to the view of that
machine.

Cluster setup

4 Cluster Setup >

Cluster Setup

Allow Automatic Match for
Printing Material
Output Tray

"Automatic Output Mode" option

The automatic output mode is enabled when you enable this option, i.e. incoming print jobs are sub-
mitted immediately to the digital printing press that meets the criteria enabled in "Allow Automatic
Match for" and is the next one available.

If you disable this option, the print jobs submitted to the cluster first go to "Waiting Print Jobs". Here
you can use the "Start with settings" context menu command to select the machine of the cluster on
which the output is to take place from the "Machine" list box if required.

. Prerequisite: The list box is available only if a cluster is selected in the device selection.
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Dialog "Cluster Setup”: "Allow Automatic Match for" options

You can use these options to define automatic distribution of print jobs. When you enable one or
more of these options, the print jobs are automatically distributed according to the enabled criteria.
Different options can be displayed depending on which presses belong to the cluster:

+ Printing Material

Printing material parameters such as size, grammage, paper type, grain direction, etc. are taken
into account when selecting the press. Depending on the setting of these criteria, the press
whose printing material settings are best suited to the job in question is selected.

+ Output Profile

When this option is enabled, output is matched to the default ICC profile of the selected paper
on the press. However, this matching is done only if the machine type automatically assigned
differs from the machine type originally assigned or if there was a change in paper.

+ Quality Options

When you enable this option, print jobs are also submitted to machines in a cluster that do not
have quality options like "Edge Enhancement” or "Maximum Inking", even if these parameters
were enabled for the submit process. In this case, these quality options are ignored.

+ Output Tray

When you enable this option, printing is automatically matched to the existing output tray
parameters of the press in the cluster. Finishing options like stitching, punching or folding are
always taken into account. This means that if a machine in the cluster does not have the finish-
ing options configured in the job, it is not automatically selected.

Automatic Workflow in the Hotfolder Mode

Another variant of automated job processing works using special folders called "hotfolders". A new
print job is created automatically whenever document files enter such a hotfolder. You can find
details about this workflow in the chapter "Automatic Creation and Output of Print Jobs in the
Hotfolder Mode", page 73.

48 Version CR 55



Introduction

Automatic Workflow by Dragging-and-Dropping
Document Files

You can use Prinect Production for automated job processing where new print jobs are created auto-
matically when you drag-and-drop document PDFs in the job list of Cockpit. In this process, it is
enough to save the required sequences as a template in a new print job. You can find details about
this workflow in the chapter "Automatic Creation and Qutput of New Jobs using Drag-and-Drop",

page 91.
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Create a Print Job manually

This chapter shows how to create a print job (example: "HDCity" booklet) manually and process it up
to printing.

] Note: The examples shown in this documentation solely demonstrate operation and must
not be understood as imperative instructions.

Create and Edit a Job

After you prepared the sequences that are needed (see the section "Configure Sequence Templates",
page 31), all the prerequisites required for creating a new job are met.

Prerequisite: All the prerequisites required for creating a print job in the Prinect DFE are
listed once again below:

- The document file(s) to be printed: HD_City.pdf in our example
- Customer: HD Printshop

- Sequence templates: "HDCity_Group_Template" with "Qualify_HDCity" and "Page-
Print_HDCity" sequences.

Create a New Job

1. In the Prinect Cockpit, go to "Jobs" and click "New Job". The "Create new Job" dialog opens:
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HEIDSLB=RG

2. This dialog has four views that you can go between with "Next" or "Back". First fill out the boxes
in the "Basic job data" view.

- Assign a job number. You can take the job number, for example, from the job ticket of a
customer job. Job numbers must be unique in the Prinect system environment. This
means that each job number can be assigned only once. In this example, we will assign
"HDOO0O1" as the job number.

- Your next step is to assign a job name. Job names as well must be unique. When you go
to the "Job Name" box, the job number is copied automatically to this box. You can use
the job number e.g. as a prefix for the job name or overwrite it. We will assign
"HDOOO1_HDCity" as the job name.

- In the "Documents" box you could now assign the documents (supplied by the customer)
to the job. You can also do this step later in the created job. We will not assign any doc-
uments at this point.

- By default, "Job Group" and "Job Home" are linked. This means that if you define a new
job group, a folder of the same name will be created automatically for this job group. We
want to create a new job group and click "Change". The "Select Group" dialog opens:
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%] Select Group *

Select Group

Selecta group! You can add subgroups with '+,

« Click the plus sign beside
"PRJOBS". Another edit

Job Group: /PRJOBSMyPrintshop box displays.

+ We will assign "MyPrint-
shop" as the group name
and click "OK". The "Select

Cancel Group" dialog closes.

3. Enable the "Start Job" option. Leave "Maximize Job View" disabled.

4. Click "Next" to open the "Customer Data" view:
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'E Create Mew Job

K

Customer Name:
Customer ID:

Mickname:

Customer Job 1D: HDOoo

CustomerJob Mame: |HDOO01_HDCity

<< Back

1 @ customer to the job.

Cancel

5. Select "HD_Printshop" in the "Customer Name" list box. This item is taken from Prinect's cus-
tomer administration. "Customer ID" and "Nickname" are also taken from there. "Customer Job
ID" and "Customer Job Name" are copied from the basic job data you defined beforehand. You
can overwrite these items if you have other customer job data that differ from the job data set
in the Prinect system. We will leave these items as they are.

54

Click "Next" to open the "Processing” view: In this view, you can add prepared sequence tem-
plates to the job. Click "Add". The "Select Templates to Add" dialog opens:
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] Select Templates to Add *

Find...

7. Select "HDCity_Group_Template" and click "OK". The group template contains all the sequence
templates needed for processing this job.

= Note: Instead of the group template, you could also add Qualify and PagePrint as separate
sequence templates. In this case, the same functionality would be available.
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H] Create New Job *

| & HDC ity_Group_Template

[ save as default
-Prinect Archiver Fro

Sener
Folder Template:

<< Back Cancel

8. Enable "Save as default". In this case, the "HDCity_Group_Template" will be automatically
assigned to all new print jobs that you create in future. If required, you can undo this assigned
template by marking the group template and clicking "Remove" and then assign other sequence
templates or group sequence templates. In addition, the group template is enabled for auto-
mated job processing. See chapter "Automatic Creation and Output of New Jobs using Drag-
and-Drop" and chapter "Automatic Creation and Output of Print Jobs in the Hotfolder Mode".
Click "Next".

9. The "Scheduling" view opens. In this view, you can select the person responsible, enter a due
date, set the job type and assign a job priority. Leave these settings as they are. Enter "36" in
the "Pages" or "1Ups" box. Enter "5000" in the "Delivery quantity" box.
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] Create New Job >

L

[0 setDue Date: =

You can define settings for job planning.

Responsible:

Job type: Production

Jobh Priority: Marmal
Tup: 36

Delivery quantity: 5000

<< Back Cancel

10. All the data needed for creating the new job are now entered. Click "Finish".

The new job is created and opens in the "Job" view. Double-click the caption bar of the "Job" view to
maximize the width of the window.

- Note: In the "Job" view, several jobs can be open at the same time. Each job opens in its
own tab. You can open another tab by clicking the "plus" sign above the job tabs. In this new
tab, you can open another job without closing the jobs opened so far. You can find more
details about this in the Cockpit Online Help
"The HEIDELBERG User Interface > The Cockpit User Interface > Open Jobs View".

Edit a New Job

After you created the new job, you must run some steps in the open job.

Add documents

1. Go to the "Documents"” step. In this step, the document files that will be edited and finally
printed are copied to the Prinect workflow.
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Overview Name; HDOOO1_HDCity  Number.

2. To add the document PDF files to the job, you can either drag-and-drop the files from the file
system (Windows Explorer, Macintosh Finder) to the window (1) or you can open a file selection
dialog with the "Add Files" button (2).

3. Click "Add Files". The "Add Files" dialog first displays the content of the "PTConfig" folder on the
Prinect server.

4. In the "Look in" list box, go to the "PTDocs" folder of the Prinect server. Open the "Test-
jobs\HDCity\PDF" folder here (this job is an example; you can also use other suitable PDF files).
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Tl Add Files

Add Files

Prinect Meighborhood  Computer:

Look in: 1 PDF

Name

o

File name: HD_City pdf

Files of Type:  1up 8 s, .pdf, jpeg, Jpg, tiff, Zip, tif ps)

P Advanced Options

S

+ | Modified > | Attributes

Cancel

5. Highlight the "HD_City.pdf" file and click "OK". The PDF file is transferred to the "Documents”
step and processed immediately with the "Qualify" sequence because the "Start job" option was
enabled when the job was created. A progress bar visualizes the process status.

W NewTab X x o+

Overview Name: HDODO1_HDCity 1

(b ] Y
)63 s PR
Printing Process CAD Documents

=

Name + Status
@ HDGity pdf

Processing | &

200 0) 0 B D

Precutiing Digital Printing . Sheetfinishing Praduct Histary

ut v

7 Extension % Path
23MB  PDF DIPTI

3

Add Files... Close Job

a
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Add documents using drag-and-drop

As an alternative to the "Add files" button, you can also add PDF documents to the "Documents" step
by dragging-and-dropping them from a Windows Explorer window (or Macintosh Finder window):

1. In addition to the Prinect Cockpit, open the Windows Explorer and go to the folder where the
files you want are located.

ame: HDOOO1_HDCity  Number; HDOOOY HD printshop

o

)
Bz o o a5 B q = S/ / &

cAD Documsnts Pagss Imposition o e ccl a Shieet s o Histary

Q

</ status 2| Modification Date % | File Siz = = sl cam

Date modi

62312017

< Volume 0)
< Volume (D)
o s

*4 Homegroup

Titem 1 itemn selected 170 MB

2. Inthe example, mark "HD_City.pdf", drag it holding down the left mouse button to the "Docu-
ments" area in the open job or to the "Documents” icon and let go of the mouse button. Adding
documents using drag-and-drop to the step icon works even if the step is not open at that
moment.

ame: HDOOO1_HDCity  Number: HD000A PDF jlame: HD printshop
\or jw
%7 | />
Rz o ) g, { Fa

cAD Y DS Move | Pagss. " Praof Plates.

</ Status 2| Modification Date %/ File Size ST

= Volume (0)

< Volume (D)

o Network

& Homegroup

Titem 1 item selected 170MB

Because the job was activated before you added the files, the PDF documents are processed imme-
diately by the "Qualify_HDCity" sequence. After processing is finished, the documents will have
"Completed" as their status.
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Edit colors

In the "Colors" parameter area, you can check, for example, whether the added documents contain
spot colors. For digital printing, spot colors are normally replaced by the CMYK process colors -
unless the digital printing machine has its own spot colors that correspond to the spot colors defined
in the job. Normally, the PDF files contain the "recipes"” for spot color replacement. In our example,
we will show how you can define or modify a spot color replacement in the job settings.

1.

Click the small arrow in the top left icon (1). A list box with parameter ranges available in the job
opens. Select the "Colors" entry.

W NewTab X X+

Overview Name: HDODO1_HDCity  Number: HDODO1  Cu; ame: HD printshop # Modified

©
& - Rz W g ) @ B e & /S g

Golors cAD Dotuments of Precutiing Digital Printing  Sheet finishing Product History.

Varnish

>

New Color Import Colors... Export Colors... Close Job

a

The colors specified in the loaded documents display in this view. For example, in the "HDCity"
booklet, "PANTONE 281 CV_cmyk" displays as a spot color in addition to the CMYK process col-
ors:

e
ame: HDOOD1_HDCity  Number: HDO0O1 Cu e P 1die > o
= o
3 0. 2 ) @) O Sy )

CAD Documents P Plates Precutting DigitalPrinting  Sheetfinishing Histary

Name Source Target 2 c M L
Printing Unit 0.0 0.0 00 1000
100.0 0.0 0.0 0.0

Printing Unit o~ 004000 Al
|

=

>

New Color Import Colors... Export Colors... delete Save Ciose Job

Q
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2. The CMYK mapping values for this spot color display in the relevant table columns. These values
were already defined in the PDF files. You can overwrite the values for C, M, Y and K if you wish
to change this "color recipe". The result displays immediately in the spot color patch.

After your input, the information in the "Source" column switches automatically from "PDF" to
"Job". This indicates that spot color replacement for this color no longer uses the definition in
the PDF document but that it was modified as a "job setting" and is applied in this form to the
current print job. You can create a new spot color with the "New Color" button. You can import
spot colors available in the color tables of the Prinect color database to the job with "Import
Colors". Confirm your changes with "Save" when have finished making color settings.

3. In our example, leave the default settings as they are.

Set up and output digital printing

= Note: You can find details about these options in the Online Help of the Prinect Cockpit >
"Digital Printing Step" (invoke with the F1 key).

Go to the "Digital Printing" step. In this step, you can interactively impose (PDF) documents on a (dig-
ital) press sheet, set delivery and finishing options as well as configure the color settings of the press
and submit the imposed press sheet for output.

ame: HDODO_HDCity

(2

CAD

ton-printing Margin [l

Subject Offset (manual)

O +%s

@] » impos

[W] » Bieedand Trim Allowance

Color Matching...

The window structure is as follows:

- The left part of the window (1) is where the single pages display. These pages were already
assigned automatically to an automatically created page list.

- The preview pane (2) shows a preview of the sheet layout. The appearance of the sheet layout
depends on the imposition parameters configured in the right-hand area of the window. You can
choose between different views and use various tools to see detailed information about the
pages shown.
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+ You can set all the parameters that are required for imposing the pages on the printing material
and for setting up the press (display, finishing) in the various tabs in the setup pane (3):

- "Paper and page settings"”,

- "Layout settings”,

- "Print mark settings",

- "Color settings" and

- "Print and finishing settings".

The basic output parameters were already set up in the settings of the loaded "PagePrint_ HDC-
ity" sequence template (see section "Configure a PagePrint Sequence", page 35). Here, you can
modify the output parameters if required. These settings affect the open job.

Color settings

In the "Color Settings" tab, you can define settings for spot color replacement that cannot be set by
default in a PagePrint sequence:

ame: HDOOO1_HDCity  Number: HDOOO1 €

L")
4 ._',‘1

CAD Dacuments

In "Spot Colors" you can configure custom settings for replacing spot colors in the current job by
clicking "Spot Color Matching" (1).

" Note: The settings always relate to a specific paper type on a specific press. These settings
1 always affect all digital print jobs until you change these settings again.

The "Spot Color Matching" dialog opens:
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%3 Spot Color Matching X

Color Name

: - A B c D E
Original CDIDr i = = — . . . . .
S EEEEN
Settings . . . . .
Step Width : . . . . .

1
T Qe HEEEER

Tagged pateches cannot be output comectly on paper.

cted papertype on Jetfirre 50. AEoq: 0.76

Print Test Page... Delete

1. Inthe "Color Name" list box, first select the spot color for which you want to define a substitute
color. All the spot colors that are in the current print job are listed.

The original color displays in the middle color patch "C4" of the preview window. Modified col-
ors display around the original color. Colors that cannot be output correctly to the paper set in
the print job are marked by an "x".

The aim of these settings is to determine a color that can be output correctly, in other words, a
color that is not marked by an "x".

2. Click "Print Test Page". A test chart is printed.

- Note: Each test chart printout creates a new separate print job in Prinect Production. These
test chart print jobs are set up with the color settings that are required for a true-color out-
put.

3. Now compare the printout of the test chart with the original copy and determine the color patch
that best matches the original spot color.

4. If the deviation is still too big, enable either "Lightness/Chroma" and/or "Color Cast" in
"Correction" to set the type of color change. Now move the "Step width" slider until suitable
patches display in the preview window. The bigger the step width, the greater the differences
between each of the color patches.

5. Repeat steps 2, 3 and 4 until you are satisfied that the target color is determined accurately
enough. On the test chart, the patch with the correct color has an "address”, e.g. "B 2".
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6. Click the "B 2" patch in the "Spot Color Matching" dialog.

7. The CMYK values of the original color display in "Original Color". The values of the selected
color display accordingly in "Selected Color" (in our example, those of "B 2").

n Note: If you wish, you can manually set the color of the marked color patch by entering
CMYK color values in "Selected Color".

8. Enable "Edit alternate color in job colors" if you wish to set the alternate color only for the
current print job.

If the alternate color is to be set always for the paper type used, enable "Use alternate color
always for selected paper type "..." on (...)" and select the paper type in the "Customize
for" list box. Then these settings affect all print jobs that are printed with this paper type on this
press/on this press type. This setup is applicable until you edit it again.

9. If you are satisfied with the colors selected, confirm the dialog with "Save".

Use the "Delete" button to reset all the settings so that special spot color settings are no longer
defined for the particular paper type/press combination.

The "Paper Type" and "Output Device" boxes are for your information only.

Editing options in the preview pane

. Note: You can find details about these options in the Online Help of the Prinect Cockpit >
"Digital Printing" step (invoke with the F1 key).

In the preview pane, different view and check options are available:

- Toggle the view mode between sheet, layout, separations, area coverage and reader's spread.
+ You can use the hand tool to move the image content of the preview.

+ You can measure dimensions with the dimensioning tool.

- Use the zoom tool to set the display scale of the preview.

- Use the magnifying glass tool to zoom in on a section of an image like a magnifying glass.

+ The info tool provides detailed information about a specific part of the preview.

- The "Color Matching" function function lets you customize color reproduction in digital printing.

"Color Matching" function

Sometimes it is necessary to fine-tune color reproduction in digital printing just before printing, based
on what you see on the screen. The "Color Matching" function lets you define such color settings
based on a master page taken from the current print job. These settings only affect the print job that
is currently being edited.

Prerequisite: If this function is to be used for a realistic proof preview of the expected print
results, the screen used should be color-calibrated and suitable as a proof monitor.
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1. In the preview window, mark a page that contains one or more image objects that are suitable
for evaluating color matching.

2. Click "Color Matching". The "Color Matching" dialog opens:

%3] Color Matching x

Lightness

Contrast

Highlights

Chroma

Blue-Yellow

Green-Red

2 ’;Ea]:f

3. In this dialog, you can adjust gradation parameters "Brightness", "Contrast"”, "Highlights"
and "Shadows". You can check these parameters in a gradation curve in addition to the pre-
view.

4. Apart from these, you can also set color parameters "Chroma", "Blue-Yellow" weighting and
"Green-Red" weighting. You can review these settings in the page preview.

You can set the gradation and color data either using the sliders or by entering values.
6. There are seven buttons in the lower left part of the "Color Matching" window:

Use the five left buttons to alter the separating line between the original and the customized
area of the image preview. You can choose between the following settings:

- No separating line (the whole preview window shows the customized color data)
- Horizontal separating line, the preview is split horizontally

- Horizontal separating line, the preview is duplicated
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- Vertical separating line, the preview is split vertically
- Vertical separating line, the preview is duplicated
You can use the two "magnifier" buttons to scale up or down the preview.
7. The "Reset" button lets you reset all the settings to their original values.

8. Click "OK" to apply the settings to the whole print job and close the "Color Matching" window.

Save settings as a PagePrint sequence template

If you changed output parameters, you can save the new settings as a PagePrint sequence template.
You can then use this template for other print jobs. In the case of the current print job, you do not
have to save the settings as a separate step. They are automatically saved with the print job.

FPagePrint. HDCity

B ¢

} Source Profiles

1. The currently active PagePrint sequence displays above the parameter tabs. In our example, this
is "PagePrint_HDCity" (1).

2. Click the "Save Template" button (2). The "Save Template" dialog opens:
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] Save Template >
p

O PagePrint_HDCity

Template Mar

Comment:

Cancel New Folder... Delete

3. This is where you can assign a new name. The settings are then saved as a new PagePrint
sequence template. If you do not wish to change the name of the sequence, the existing "Page-
Print_HDCity" sequence is overwritten with the new settings.

4. Confirm the dialog with "OK". Confirm the security query by clicking on "Yes".
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Printing

1. To check your print and finishing settings, go to the "Print and finishing settings" tab. Define your

setup as required.

Note: As the Jetfire 50 presses can be equipped with different finishing options, no detailed

settings are described here.

2. Click "Submit" (1) to start printing.

Overview Name: HDOOD1_HDCity  Number: HDOOD1  Cu ame; HD printshop

: U
& 4 o .,‘ 1

Colors CAD Documents Precutting

179 Front

b [ paliet shest
b [ Insert

b [ Cutting

P Image Shift

P Print Options

Shift Mode:

Color Matching..

The "Submit" dialog opens:
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3.

70

Tl Submit

Submit 36 Page(s)

Output
© Numberofiups 5000

(O Print Amount

Print Range

O a1l O Pages (O Sheets

Priority Mormal =

P Output Options

w Details

Work Type:  MNormal = Waork Mode: | Normal

Comment:

w Scheduling

[] Do Mot Start Before #%. | 2

[] Planned Start L

[] Latest Completion &

Cancel

In this dialog, you can, for example, assign a priority, correct the number of pages/1ups or the
print amount, assign a work type, enter a comment and set the time for printing. In this dialog,
the terms "Number of pages" or "Number of 1ups" and "Print Amount" have the following mean-
ing:

- Number of pages/Number of Tups Select "Number of lups" if you wish to output a cer-
tain number of pages or lups. The number of pages/lups set are output.
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- Print Amount: This is where you can set the print quantity. The print quantity depends

on the type of product to be printed:

If a product with multiple Tups is output, such as two A4 pages on A3+ paper, the print
quantity refers to each (multiple) occurrence of each page of the PDF document.

If a product with single 1ups is output, such as a booklet, the print quantity refers to the
number of copies output.

4. The "Test Print" option (1): Enable this option if you wish to output the job as a test print to
check the quality of the color, for example. Activation of this option has the following impacts:

- The number of pages/number of Tups or print amount is automatically set to "1" because

usually you need only one copy as a test print. You can increase the number of 1ups
manually if required.

- The work type is set to "Internal”.
- The parameters in the "Scheduling" section are disabled.

- After output, a test print is not tagged as "finished".

If the job is to be output normally after the test print, all you have to do is submit it again and
disable "Test Print". The parameters set beforehand in the "Submit Elements" dialog are enabled

again.

5. If you confirm this dialog with "OK", the print job is forwarded to the digital printing terminal and
can be output to the press as soon as there are enough print jobs for continuous operation of
the Jetfire 50 digital printing press.

6. After output, you can close the print job.

Note: Please note that the Jetfire 50 digital printing press carries out an automatic cleaning
process of the ink print heads after each "print pause”. As only a single copy is printed
during a test print, such a cleaning process also takes place with each test print. To avoid
unnecessary ink consumption, it is recommended that you use the "Test print" option with
caution never enable this option as default. If necessary, check whether it makes sense to
use an additional color proofer for the page proof within the Prinect environment in order to
output proofs on this additional proofer.
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Create new Print Jobs by transferring PDF Files
into a Hotfolder.

With Prinect Production you can set up a print job in such a way that new print jobs are automatically
created when documents are filed in a folder that is set up as a "hotfolder". In this chapter we will
set up such a print job and describe how to create new jobs.

Prerequisites for the Hotfolder Mode

For this workflow, some prerequisites must be met on the Prinect server so that automated job pro-
cessing works smoothly.

. Prerequisite: The following requirements must be met for output with a reusable print job:

- A hotfolder job template must have been set up in "Administration > Hotfolder". This job
template must have all the required settings (sequences, imposition and finishing
parameters) in a suitable form.

- An "external hotfolder location” must have been defined to be able to set up a hotfolder
job template. For a Prinect installation, the "\PTJobs\External-Hotfolder" folder is
installed by default. Open "System" in "Administration" if you want to change this set-
ting. In the tree structure, mark "System", the topmost item (if necessary, you must click
"Hide Clusters"), and then click "Browse..." in "External Hotfolders Location" on the
right. In the dialog that then displays, you can select a different folder or create a new
one. You can also define the "External Hotfolders Location" on another computer than
the Prinect server. You can find more details about creating an external hotfolder loca-
tion in the Online Help for the Prinect Cockpit in "Administration — System". In our
example, we will leave the default "\PTJobs\External-Hotfolder" as it is.
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- The sequences required must have been assigned to the job template, either separately
or as a group sequence. This ensures the automated processing of printing.

- The documents to be output must be able to be edited without an error and their page
size must match the imposition settings in the PagePrint sequence. The number of pages
does not have to match the page amount defined originally in the PagePrint sequence. It
will be matched automatically during output.

Disable Preview Handler in Windows Explorer

The Windows Preview Handler is responsible for displaying previews of the different file types such
as image or document thumbnails in a Windows Explorer window. Windows creates such thumbnails
automatically.

Problem: A Prinect hotfolder can no longer be polled correctly if the Preview Handler needs more
than six seconds to calculate an image thumbnail. As a result, the PDF documents will not be pro-
cessed. For security reasons, you must disable the preview handler.

1. Open a Windows Explorer window and invoke the "Folder Options" dialog (either with "Tools >
Folder Options" if the menu bar displays or with "Organize > Folder and Search Options" or with
"View" > Options > Change folder and search options") (Windows 8.1/Windows 10/Windows
Server 2012 R2/Windows Server 2016):

= | E\PTDocs\Testjohs\HDCity\PDF — [m] b4

B meevewpane | Edrlarge icons B Large icons k| Medium icons [ Group by - [ ttem check boxes ] =
T small icons £ List == Details ns - File name extensions

Navigation =
e [EDetails pane  [E= g1, calumns to fit Hidden items

Panes Layout Current wiew Showithide [ [F] Change folder and search options }

m= Hide selected  |Optians
2= content tems -

« v > ThisPC » E_DATA(E) » PTDocs » Testjobs » HDCity » PDF v O Search PDF P

~

2. Open the "View" tab and disable "Show preview handlers in preview pane".
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Folder Options *

General Yiew  Search

Faolder views
‘r'ou can apply this view [such az Details or [cong] to
all folders of this type.

Apply ta Folders Reset Folders

Advanced zettings:

1 Launch falder windows in a separate process '
] Restore previous folder windows at logon
Show dive letters

st st
1 Shows syne provider natifications
[ Use check boxes to select items
1 Use Sharing Wizard [Recommended)
wihen typing into list view
() Awtomatically bpe into the Search Box W

Festore Defaults

K Cancel Apply

3. Confirm the dialog with "OK".

Prepare a Print Job

We will use the "HD_City.pdf" booklet print job as our basis, like in chapter "Manual Creation of a
Print Job", page 5I.
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Set up a Qualify sequence for the hotfolder mode

Fle | Edit | View | Tools | Hel |

B o & B B B

1. In Cockpit, switch to the "Administration > Templates" view, open the "Qualify" sequence type
folder and select "Qualify_HDCity" (1). Click "Open" (2). Alternatively, you can also open the
sequence by double-clicking it.

The setup section for the "Qualify_HDCity" sequence opens:

Overview

Qualify_HDCity (Qualty)
N AllHotfolders

Set this sequence as follows:

2. Leave "Normalizing", "Split Document”, "Preflight" and "Destination" as they are.

)

3. Enable "Hotfolder" and set the following parameters:
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Overview:

Qualify_HDCity (Quality)

on  AlHotfolders

a. In the "Hotfolder" box (1) leave the "$Template" setting as it is. This setting makes sure
that the file names of the job documents are used for the names of the new jobs.

b. Enable the "in External hotfolder location" option (2). With this option, the new jobs are
stored in the set hotfolder location on the Prinect server.

c. In "Insert into external hotfolder path" (3), leave "Job number" as it is. By doing this, a
separate subfolder with the job number as the folder name is created for each job.

d. Enable "Create new job and process document there" (4). When this option is enabled,
new jobs are created automatically when document files are filed in the hotfolder.

e. Select "Keep existing process network" in the list box (5). In this list box, you control how
a process network is created automatically from components of the job name, among
other things from the product code. A process network is a combination of print job,
press sheets and sequences. No Smart Automation workflow will be used in our example
and, for that reason, no new process networks will be created using this functionality.

f. In the "Job group for new job" list box (6) leave "Current job group" set. The new jobs
generated are created in the same job group as the original job.

g. Set "Create and use job with a new job number" in the "When job number already exists"
list box (7). Based on the existing job number, a new job number is created by appending
an index. After that, a new job is created with this job number.

You can use "The file name contains" to determine detection rules for interpreting the file
names of the PDF files you want to process by detecting and using certain parts of the
file name as job parameters. You will find more details about these detection rules in the
Cockpit Online Help in the "Sequence Templates" section in "Preparation > "Qualify"
Sequence Template > Hotfolder" option.

We will use a simple example and generate only the job number and job name from the
file names.
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h. To do this, select "the job number" in the "in position 1" list box (8). Check the "from first
character" option (9) and enter the character "#" in the "up to delimiter" box (10). As a
result, the file name of the filed documents is interpreted in such as way that all charac-
ters before the "#" in the file name are identified as a job number and are used for the
new jobs. The file names of the filed documents must have this delimiter and appropri-
ate characters for the job number in order for new jobs to have a job number.

i. Then select "the job name" in the "in position 2" list box (11). The "from first character"
option remains disabled. Enter the character "&" into the "up to delimiter" box (11). This
character acts as a rear limitation for the job name. All characters between these two
delimiters in the file name of the filed documents are used as the job name.

Example: A document named "1234#Brochure_HD&.pdf" creates a job with the number
"1234" and job name "Brochure_HD".

Caution: When you define job names, make sure that job names and job numbers are
always unique in a Prinect system. A new job will overwrite an existing job if the new job is
created in the hotfolder mode and its job name and job number match those of the existing

job!

4. Leave the other steps as they are and click "Save as".
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Save Template >
p

Qualify

Template Nam

Camment:

Customer 1D 0001 Edit...

Product Co it Eudit...

Product : Edit...

Cancel New Folder... Delete

5. Enter "Qualify_AutoJob" as the name. Confirm the "Save Template" dialog with "OK".

6. Click "Close". The sequence overview displays.
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1' Templates

Criterion Machine Created on Created by Date Modified

3:31 PM Heidelberg Mar 5, 2024, 12:34:57 P

2024, 4:04:30 PM German D

D@pOEDRDODDDDDDD

New Foider... Open Delete Succession... Properties...

Create a group template for automatic job creation

1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click
"NeW"_

The empty setup window of a group template opens.

1’ Templates

Add Template

2. Open the "Qualify" folder and select "Qualify_AutoJob" (1).
3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.

4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as
follows:
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Add Tempiate

Save as... Close

5. In the workspace, select "AutoArrange” in the context menu. The icons are placed side by side
and aligned.

6. Save the group template as "AutoJob_Group_Template" using "Save as".

7. Close the view by clicking "Close". Then click "Overview".

Automatic creation of print jobs

After the Qualify sequence is configured, a new print job template is now created in "Administration
> Hotfolder" and is used for automatic job creation. Hotfolder job templates do not display in the job
list so that they are not inadvertently deleted. Administration of these templates is solely done in
"Administration > Hotfolder".

Create a hotfolder job template

1. In Cockpit, go to "Administration" and click the "hotfolder" icon.

The section for setting the hotfolder job templates opens. Click "New".
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Set up the job template as follows:

2. Enter "MyAutoHF" as the name.

3. Leave "with current date" enabled in "Job group for new job". This setting generates a separate
job group with the current date as the group name for all the jobs created on this day.

4. Click "Import" in "Processing”. Select "AutoJob_Group_Template" in the "Select Templates to
Add" dialog.
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Select Templates to Add *

Confirm with "OK".

5. Click "Save". The hotfolder configuration area is now as follows:

ansfsAExternal_HFyAutoHF

Job group for new job

Import...

Edit Hotfolder Job

The new job template, "MyAutoHF", displays on the left of the window. You can create other hot-
folder job templates with "New", if required. We now close the view by clicking "Overview". The
hotfolder job template is now set up.
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Create a New Job by Filing to the Hotfolder

After you prepared the job template for automatic job creation in the hotfolder mode, job processing
can begin.

Prepare Document File Names

Delimiters were defined in the hotfolder settings of the Qualify sequence and they can be used to fil-
ter out the job number and job name from the document file names. We will customize the file names
of the PDF documents to be output so that we have useful job numbers and job names.

Caution: When you define job names, make sure that job names and job numbers are

always unique in a Prinect system. A new job will overwrite an existing job if the new job is
created in the hotfolder mode and its job name and job number match those of the existing
job!

We will use the "HD_City.pdf" document again as the example document (see section "Automated
Output of Documents", page 96).

Create and start a new print job

1. We will create a new folder named "PTDocs\Testjobs\HDCity_AutoJob" and copy "HD_City.pdf"
to this folder. The file will be renamed to "GSO0010#HDCityA4&P01_P36.pdf". Based on the set
delimiters "#" and "&", a new job with job number "GS0010" and job name "HDCityA4" will be
produced.

To output "GS0010#HDCityA4&P01_P36.pdf", you will now copy it to the hotfolder of the
"HMyAutoHF" template job:

2. In the Windows file system, mark the file and select "Copy" in the context menu or click the
"Copy" button.
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+ | E\PTDocs\Testjobs\HDCity_Autolob

Home Share i e

I
B O

Pinto Quick Copy  Paste
access

-

& cut 4 B x iﬁ

Copy Delete Rename
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-

W Copy path
Plewy
folder
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7| Paste shortcut toT

Clipboard Qrganize ey

» E_DATA(E) » PTDocs » Testjobs » HDCity_Autelob

1 Mame
1™ GS0010#HDCityA4&P01_P36.pdf

€ > v

-

Testjobs "

4up_FE_ID_Submit
BusinessCards

data

Diverse
Golfstory-16Pages-3C-A4
HD_City_Brochure
HDCity

HDCity_Autoleb
HDTest-20Pages-4C-A4
ImposePDF
ImpositionLayouts
ImpositionCQutput_Default_Tiff-B_Export

PostCardsCaribbean
W

State: a Shared

Drctart arihheantamed ™
1 item selected 23.6 MB

1item

— O X
| Cpen Select all
] Wown- BB
Edit Select none
Properties
- DD Invert selection
Cpen Select
w | D Search HDCity_Autolob 0

Date modified Type

6/22/2005 10:58 AM  Adobe Acrobat D...

>
=

3. Go to the hotfolder of the "MyAutoHF" job. You will find this folder on the Prinect server in the

"PTJobs" folder and there in "ExternalHotfolder\MyAutoHF".

4. Paste the copied PDF file into this folder. By inserting the PDF file, you automatically generate a

new print job.
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| = | E\PTJobs\ExternalHotfolder\MyAutoHF — O X
Harme Share Wi . 0
» = cut x I - il open - EHselectal
Wl Copy path 43 ﬂ' ¢ Edit 00 select none
Pinto Quick Copy  Paste = Mowve  Copy Delete Rename ey Properties
access El Paste shartout to to - falder - E‘E‘ Invert selection
Clipboard Organize e Open Select
& v » E_DATA(E:) » PTlobs » ExternalHotfolder » MyAutoHF v O Search MyAutoHF el
ImpositionLayouts A [0 MName Date modified Type
ImpositionOutput_Default_Tiff-B_Export
PeostCardsCaribbean View >
PosterCaribbeanHomedC Sort by >
PostScript S >
Refresh
Sport_LowRes e
PTlobs Customize this folder...
AD-PDF Paste
DigitallobBags Paste shortcut
ExternalHotfolder FrerzmfT
AutoHF
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InspectionControl
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Jobs
ShapePool
e v = L
Ditems  State: 3& Shared =

5. In the Cockpit, go to "Jobs" and there to the job list. After a brief period, a new group with the
current date displays below "PTJOBS". This group contains the new job "GS0010".

= (3 Job Group % ssic Fi Q Overview

Job Number S JobStatus  + JobFlags S Fm

0"
Colors

Browse...

Name: HDCityA4  Mumbe

—
8 o @ 1 gd
CAD Documents

=

Name < Status

# GS0010#HDCIyAIERO1_P36 pe

This job starts, is processed and can be output automatically.

Add Files...

Close Job

Q

6. To output the print job, wait until the documents are processed and then go to the "Digital Print-

ing" step.
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(7). If required, you can customize your settings in this step (see section "Set up and output digital
printing", page 62).

n e
Overview Name: HDCityAd  Number. GS0010 P ldle > L

i)

Histary

[#] non-printing margin i

Subject Offset (manual)

O] ke O v+

[W] » imposition Trimmed Size

[B] » Bleedand Trim Allowance

Color Matching...

8. Click "Submit" (1). The "Submit Elements" dialog opens:
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Tl Submit Fe

Submit 36 Page(s)

Output
© Numberofiups 5000

(O Print Amount

Print Range

O a1l O Pages (O Sheets

Priority Mormal =

P Output Options
w Details

Work Type:  MNormal = Waork Mode: | Normal

Comment:

w Scheduling
[] Do Mot Start Before 8.
[] Planned Start L

[] Latest Completion &

Cancel

9. In this dialog, you can finish off, for example, by running a test print (1), assigning a priority, cor-
recting the number of pages/lups or print amount and/or entering a comment.

10. The print job is output to the press when you confirm this dialog with "OK".
1. After output, close the print job.
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Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.
Caution: When the "master job" stops, the related hotfolders will also be deleted! For that
reason, make sure that the condition of the master job is always "Idle".

In this way, you can automatically generate more print jobs.
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Create new Print Jobs automatically via Drag &
Drop

Prinect Production lets you use a predefined print job as a template for other print jobs and outputs.
The documents of the subsequent print jobs are then processed with all the job settings of the tem-
plate job. To create and start a follow-up job, you only have to drag-and-drop the PDF documents you
wish to output from Windows Explorer (or Macintosh Finder) to the relevant job in the job list in Cock-
pit. This process will be described in more detail below.

Prerequisites for the Drag-and-Drop Mode

For this workflow, some prerequisites must be met on the Prinect server so that automated job pro-
cessing works smoothly.

. Prerequisite: The following requirements must be met for output with a reusable print job:

- A print job for digital printing must be defined as a template job and it must have all the
required matching settings (sequences, imposition and finishing parameters).

- The print job condition must be "Idle" and the processing status must be "OK". The print
job must be closed before output and it must be seen in the Cockpit job list.

- The sequences required must have been assigned to the print job as a "template”, either
separately or as a group sequence. This ensures the automated processing of printing.

- The documents to be output must be able to be edited without an error and their page
size must match the imposition settings in the PagePrint sequence. The number of pages
does not have to match the pages total defined originally in the PagePrint sequence. It
will be matched automatically during output.
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Prepare a Print Job

We will use the "HDOOO1_HDCity" booklet print job as our basis, like in chapter "Manual Creation of
a Print Job".

After the "HDOOO1_HDCity" job was configured and used successfully for output of the "HD_City.pdf"
document, you will now create a similar job for automated output.

HDDOO1_HDCity B idie

i March 14,2025 Tt

1. Go to the "Jobs" view, mark the "MyPrintshop" group in the job list and click "New job".

2. Fill out the "Basic job data" view as follows:
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Fi] Create New Job >

R

Job Mumber:
Job Mame:
Documents:
Jaoh Group:
Job Home:

[ startJab

Please enter a number and a name far your new job.

HDDooz2 ] Automatic

Browse...

IPRJOBSIMyPrintshop Change.:

[ maximize Jok View

« Job number: HD00O02.

- Job name:
+ Job Group

« The "Start

HD0002_ Auto_DD.
: MyPrintshop (is set by default).

Job" option is disabled. Click "Next".
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'ﬂ Create Mew Job

K

Customer Mame:
Customer ID:

Mickname:

CustomerdJob D:

CustomerJoh Mame:

Basic job data [

You car

0oo1

HDF

HDOooz2

HDOD0Z_Auto_DD

<< Back

ign a customer to the job.

Cancel

3. Select "HD Printshop" as the customer in the "Customer Data" view. Then click "Next".
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Fi] Create New Job >

=

Basi ata Customer Data

You can assign seguence templates or group templates to the job.

| & HDC ity_Group_Template

[ save as default
-Prinect Archiver Fro
Sener

Folder Template:

<< Back Next == Cancel

4. Inthe "Processing” view, "HDCity_Group_Template" is already set by default because we added
this group sequence template with the "Save as default" option to the manually created job (see
chapter "Manual Creation of a Print Job"). If you wish to add other sequences to the job, you can
do this by using "Add". You can remove existing sequences - including group sequences - from
the job by marking them and clicking "Remove".

5. No scheduling data will be entered because the job is being set up as a reusable template for
automated printing. For that reason, we will skip "Scheduling". Click "Finish".

The job is created and opens.
6. Double-click the caption bar (and not the tab "Job" window, but next to it) to maximize the width
of the window. All the job settings and the "Documents" and "Pages" steps remain unchanged

because different documents with the same settings will be output in an automated workflow.
Go directly to the "Digital Printing" step (click this icon in the workflow bar).

All the required output settings are already configured because the "HDCity_Group_Template"
contains the preset "PagePrint_HDCity" sequence template.
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W NewTab X x +

Overview Mame: HDOOD2_Auto_DD  Number: HDO002  Cus

(>
4 .7n
C

Daocuments

111 Front

7. Leave the settings as they are. You will find more details about the "Digital Printing" step in the
section "Set up and output digital printing", page 62 or in the Cockpit Online Help (F1 key).

8. Start the job by clicking the start button (1).

9. This concludes your preparations for the automatic job. Close the job with "Close Job". All set-
tings are saved automatically.

Automated Output of Documents

1. Open the Cockpit and view the job list on the left in the "Jobs" view.

2. If necessary, open the job group (in our example, "MyPrintshop") that contains the prepared job
and make sure that the "HD0002" job can be seen.
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= Job list

= O Job Group + -
Job Number 5 Job Status < Job Flags =

»
-
-
-

HD0002

We will use the "HD_City.pdf" document again as the example document.

5
2
2
[
B
£
2
a8

3. Open a Windows Explorer window (or a Macintosh Finder one) and go to the folder which holds
the PDF file to be output. This folder must be located on a local drive, data medium or on a

shared network drive of the Cockpit computer.

Fle | Edit | View | Job | Tools | Help |
=] = S
b 5 & BB B
= Joblist

= O JobGroup +

Job Number L < JobStatus % JobFlags &

HDODO1_HDGity B> ldle
HDoo02
HDOO02_Auto_DD

| DAAPTDocs Testjobs\HDCty-36Pages-A4\PDF
St Freigeben  Ansient
~ 4 ||« PTDocs » Testiobs > HDCity-36Pages-A4 > PDF

Calibratiol A Name

Certificates T2 HDCitypdf
Color Proof Pro

Common Services
db_backup

DFE

DFE Versafire

GPI

HD_Temp

help

High Performance Renderer

v & | "PDF" durchsuchen
Anderungsdatum  Typ

21112024 16:10 Adabe Acrobat.|

4. Select the PDF file(s) and drag them, holding down the left mouse button, to the "HD0002" print
job entry and let go of the mouse button. The job then opens automatically and displays in the

"Job" window.

5. To print the print job, maximize the width of the "Job" window (double-click the caption bar) and
go to the "Documents” step. Wait until the documents are processed and then go to the "Digital

Printing" step.
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Name: HDOOO2 Auto DD Number: HD0002  Customer Name; HD printshop

)
[ et B Cal
Documents fups. Impasition Froof

e

Precutling History

v+—EI‘

Hon-printing Margin [l

Subject Offset (manual)

O = oo| OO wre

[W] » imposition Trimmed Size

W » BleedanaTrima

Color Matching.

(6). If required, you can customize your settings in this step (see section "Set up and output digital
printing", page 62).

7. Click "Submit" (1). The "Submit Elements" dialog opens:
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Tl Submit Fe

Submit 36 Page(s)

Output
© Humberoflups | 5000
(O Print Amount

Print Range

0 a1 O Pages (O Sheets

Priority Mormal =

P Output Options
w» [Details

Work Type:  MNormal » Work Mode: | MNormal

Comment;

w Scheduling
[] Do Mot Start Before #%. | 2114125 2:31 P
[] Planned Start "

[ Latest Completion #®-

Cancel

8. In this dialog, you can, for example, finally assign a priority, correct the number of pages/lups
or the print amount, assign a work type, enter a comment and set the time for printing.

9. Ifyou confirm this dialog with "OK", the print job is forwarded to the digital printing terminal and
can be output to the press as soon as there are enough print jobs for continuous operation of
the Jetfire 50 digital printing press.

10. After output, close the print job.
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. Note: Please note that the Jetfire 50 digital printing press carries out an automatic cleaning
process of the ink print heads after each “print pause". As only a single copy is printed
during a test print, such a cleaning process also takes place with each test print. To avoid
unnecessary ink consumption, it is recommended that you use the "Test print" option
with caution never enable this option as default.

Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.
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